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1 About this guide
This guide is intended as a supplement to the main documentation for QuadHead2Go and Matrox
PowerWall.
Before using this guide, you should have already set up your physical video wall, connected the
monitors to your QuadHead2Go device, and installed the Matrox PowerWall software.
For more information on how to install, configure, and use QuadHead2Go or Matrox PowerWall,
refer to the specific documentation for each product.
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2 Overview
This guide describes how to use the QuadHead2Go Bezel Adjustment grid to adjust your video wall
setup to account for the gaps between monitors. This will allow you to optimize your video wall setup
to get the best possible visual experience.
There are two kinds of video walls:


Grid video walls: Two or more monitors are combined to form a larger rectangular video
wall. All monitors are the same size and ideally the same model.



Artistic video walls: Two or more monitors are combined to form a more complex video
wall that can take different shapes. Monitors can be different sizes, and may be placed
farther apart than a simple grid video wall.

The adjustment process is similar for both types of video walls, but artistic video walls require more
planning and fine tuning to implement successfully.

2.1 About Grid video walls
A grid video wall uses two or more monitors to create a continuous display across one large screen in
either portrait or landscape orientation, such as in the examples below:

Portrait 3 x 1 Video Wall
Landscape 2 x 2 Video Wall
Landscape 1 x 2 Video Wall

To get the best results when building a grid video wall, your monitors should be as close to each other
as the physical space and environment allow. However, the video/image quality may still be affected
by the gaps between the monitors, and the physical bezels on the monitors themselves. The Bezel
Adjustment Grid along with the Bezel Management feature in the Matrox PowerWall software will
help you adjust and optimize your setup to account for the gaps and monitor bezels.
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2.2 About artistic video walls
Artistic video walls do not follow a typical grid or rectangular layout, and can include a variety of
monitors of different sizes. Unlike grid video walls, artistic video walls may also include monitors
placed in different orientations (portrait or landscape) within the same setup. As such, you must take
more time to plan your setup and bezel adjustment may be more challenging depending on the
complexity of the wall you want.

Single device Artistic Video Wall

Multi device Artistic Video Wall

The Bezel Adjustment Grid along with the Bezel Management feature in the Matrox PowerWall
software will help you adjust and optimize your setup to account for the gaps and monitor bezels.

2.3 About the Bezel Adjustment Grid
The Bezel Adjustment Grid is a pre-generated grid pattern that can temporarily replace the Input
Video source. The grid is composed of:


Gray background.



Horizontal and vertical lines alternating in black or dotted black and white.



Diagonal colored lines.



Blue outer edge border (for single device only).



Red diagonal lines crossing in the center of the Input Video source.



X (in green) and Y (in yellow) coordinate for each bloc row and column.



Centered overlay ID identifying each display output number (not impacted by any
scaling/positioning).

You enable the grid by pressing Button 1 on the QuadHead2Go device, and selecting it from the
Source Selection menu, or with the PowerWall application via the Device Management section.
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This Bezel Adjustment Grid can calibrate one or more QuadHead2Go devices that share the same
input source (e.g., using clone mode or a splitter device). It can also calibrate between multiple
QuadHead2Go devices each with a different input source.

2.3.1 Example of the Bezel Adjustment Grid
The Bezel Adjustment Grid automatically creates a pattern matching your video wall configuration.
The example below shows an example for various Grid video walls.

A typical 2 x 2 landscape grid

A typical 3 x 1 portrait grid

A typical 2 x 1 landscape grid

2.3.2 Features of the Bezel Adjustment Grid
The Bezel Adjustment Grid includes several elements to help you align the input source for the
physical monitor setup:


Vertical and horizontal lines help with orthogonal (right-angle) positioning of the
monitors.



Diagonal lines help with adjusting the spacing between monitors.
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X and Y coordinates help with positioning when there are large gaps between monitors.

A zoomed-in portion (600 x 600) of the grid

2.4 Confirming the monitor orientation and position
Use the outside blue border of the Bezel Adjustment Grid along with the overlay ID (1 and 2 in this
example) to confirm that monitor position and orientation is correct. If it is not correct, the monitor’s
orientation can be corrected within Matrox PowerWall or by physically rotating the monitor.

Incorrect orientation

Correct orientation
(blue border on the outer edges,
ID properly oriented)
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2.5 Confirming the display ratio
The Bezel Adjustment Grid pattern uses a square pixel aspect ratio (1:1). If your source pixel aspect
ratio is also square, then the pattern formed by the horizontal and vertical lines in the grid should
always appear as square. Non-square pattern, indicates a distortion of the image most likely due to an
invalid display resolution or bezel adjustment. For example, the monitor’s display settings may be in
“wide mode” which stretches the image to fit the screen size.

This image is stretched. The pattern appears as a rectangle instead of a square.

2.6 Aligning the grid across monitors
Horizontal, vertical, and diagonal lines crossing gaps between two monitors help verify that the image
is properly displayed.
If the monitors are close enough to each other, you can use a straight object like a ruler, pen, or even
a piece of paper to help you visually verify that the lines would connect if the gap was not there. From
a distance, you can take a picture and verify the lines are properly aligned with it.
In the example below, there are two pairs of monitors positioned vertically. One pair is properly
aligned and the other pair is not. The white line represents the small physical gap between the
monitors. The black region represents the physical frame of the monitors. The green lines should
appear aligned across the gap, as if the gap was not there at all (as shown in the image on the right).

Not aligned. Green lines do not line up
between top and bottom monitors.

Aligned. Green lines correctly line up
between top and bottom monitors.
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3 Adjusting grid wall bezels in Matrox
PowerWall (single device mode)
The following Grid Wall setup will be used as an example in this section.

The input’s source media is in UHD resolution, connected to one QuadHead2Go device with four
HD monitors (24”) in 2x2 landscape mode.
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3.1 Grid wall creation and setup
This section describes the initial setup of your Single device design grid wall in Matrox PowerWall.
1

Open Matrox PowerWall, click File > New design > Single device design, then click OK.

2

Give your media a name, select your source image, then click OK.

The source image is for use within the Matrox PowerWall application only.
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3

Select your desired wall configuration, then click OK.

The Matrox PowerWall window opens to show the Physical display and the Source
display for the selected configuration. You can access all settings from the sliding panel
Menu.

1: Physical display
2: Source display
3: Sliding panel menu

This guide will focus on the physical view window. The source window view is used for
more complex cases.
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3.2 Enabling the Bezel Adjustment Grid
For live bezel adjustment, the Matrox PowerWall design must be assigned to a physical device.
Uploading the design will send the current design information to the device. This step can be done
after each change in the design to see its impact, and must also be done prior to switching to Live
mode.
1

Assign the design to a device.

1: Device data transfer tab
2: List of physical devices
3: Upload button

a

Go to the Device data transfer tab.

b

Select a device from the list.

c

Upload your design to the selected devices.
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2

Enable the Bezel adjustment grid.

1: Device management tab
2: Input source list
3: Apply button

a

Go to the Device management tab.

b

From the Input source list, select Bezel adjustment grid.

c

Click Apply.

Your video wall monitors will now display the Bezel Adjustment Grid with each monitor
showing an overlay ID (monitor number):
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3.3 Adjusting the relative source position
1

Specify the models for all monitors used for your wall.

1: Output settings tab
2: Monitor management section
3: List of monitor manufacturers and models

a

Go to the Output settings tab.

b

From the Monitor management section, select the Manufacturer and Model for the
currently selected monitor.
If you can’t find your monitor(s) listed, select the generic manufacturer option with
the model that matches the diagonal size of your actual monitor(s).

c

Repeat for each of your active monitors.

With a specific monitor model, bezel information will be available and used for the setup
of the monitors, resulting in minimal adjustment. The generic model will only show the
active portion of the monitor, and more adjustment will be needed to account for the
monitor’s bezel. In either case, Matrox PowerWall allows you to achieve the same end
result.
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2

If your monitors and media source are no longer aligned after selecting your monitor
model, you can reposition them.

1: Monitor repositioning
2: Input management tab
3: Keep aspect ratio
4: Maximize button

a

In the physical view, reposition each monitor relative to the others. The monitors
will snap into position if the snap feature is enabled in the Settings menu.

b

Go to the Input management tab.

c

Select Keep aspect ratio to prevent a distorted output.

d

Click Maximize to resize each monitor to the best fit of the source.

16

3

After changing the monitor model or media source size, you must reset the width and
height of each monitor to reset the scaling factor.

1: Output settings tab
2: Source position section
3: Reset button

4

a

Go to the Output settings tab

b

From the Source position section, click Reset.

c

Repeat for each active monitor.

Enable Translate mode and Live mode.

1: Output settings tab
2: Source adjustments section
3: Mode list
4: Live mode enable/disable
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5

a

Go to the Output settings tab.

b

From the Source adjustments section, select Translate from the Mode list.

c

Enable Live mode to immediately apply the adjustment to the monitors.

Adjust the bezels in Live mode.

1: Live mode enable/disable
2: Translation adjustments

a

Make sure Live mode is enabled.

b

While looking at the physical display, make the needed Translation adjustments
using the Top, Bottom, Left, and Right positions per monitor

c

Use the grid lines displayed on the monitors to help make the proper adjustments.
At this point, you may see black bars appearing on some monitor edges.

18

d

6

Adjustment should be done in the following sequence with the top-left monitor
acting as the initial reference point. Translate the other monitors one at a time using
the grid lines shared with the reference monitor. After the second monitor is
adjusted, it also becomes a reference for its shared edges with the other monitors.
Continue until you have successfully adjusted all monitors.

(Optional) Adjust the bezels when the Source position is known. This is useful when you
know the monitors’ bezel sizes in pixels.

1: Output settings tab
2: Source position section
3: Left and Top positions

a

Go to the Output settings tab.

b

From the Source positon section, enter the Left and Top positions for each monitor.

c

Upload the design for your changes to take effect.
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3.4 Scaling and centering the source
1

Disable Live mode to apply the live mode adjustment to the design.

1: Live mode
2: Physical view
3: Source view

The change will be displayed in the Physical view and Source view windows. Some
monitors may be outside the media’s source window (black bars around the edges).
2

Scale the source to cover all the monitors’ active pixels.

1: Input management tab
2: Source adjustments section
3: Maximize button

a

Go to the Input Management tab.

b

Select Keep aspect ratio.

20

c

Click Maximize.

After the source is stretched, some of the pixels from the source will no longer be visible.
3

Center the monitor source.

1: Output settings tab
2: Source position section
3: Left/top settings

a

Go to the Output Settings tab.

b

From the Source positon section, apply the same horizontal and/or vertical offset to
all monitors.

c

Upload the design for your changes to take effect (you can also do this in Live mode).

3.5 Validating your display wall
After you have adjusted the display wall, verify the following:


All horizontal and vertical lines are aligned across the gaps.



All diagonal lines are aligned across the gaps.



The vertical and horizontal line form square patterns (not rectangles) when the source
has a 1:1 pixel ratio.



For an optimal fit, the blue border should be visible horizontally or vertically

Once the validation process is complete, you can remove the Bezel Adjustment Grid.
1

Go to the Device management tab.

2

From the Input source list, select Video input, then click Apply.
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4 Adjusting grid wall bezels in Matrox
PowerWall (Multi-device mode)
The following Multi-device Grid Wall setup will be used as an example in this section:

There are two source media inputs, both UHD resolution, each connected to a QuadHead2Go device
with four similar HD monitors (39”) in a 2x2 landscape mode.

4.1 Grid wall creation and setup
This section describes the initial setup of your Multi device design grid wall in Matrox PowerWall.
1

Open Matrox PowerWall, click File > New
design > Multi device design.

2

Define the total size of your Physical wall
(you can change these dimensions later).

3

Click OK.
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The PowerWall window opens with your physical wall represented in light gray.

1: Media panel
2: Device panel
3: Physical view
4: Source view
5: Menu panel


You add and select a media source from the Media panel.



You add and select a device from the Device panel.



The light gray area represents the Physical view of your video wall.



Under the Physical view is the Source view section.



Access the PowerWall settings from the sliding Menu panel.

This guide will focus on the physical view window. The source view window is used for more complex
cases.
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4.2 Add media sources
1

Click the (+) button in the PowerWall window to add a new media source.

2

Give your media a name, select your Source image, define the Aspect ratio and Size,
then click OK.
The physical size represents the dimension of the source applied on the physical video
wall. The source image is for use within the Matrox PowerWall application only. When
you have multiple media sources as part of a design, you can simplify the design process
by assigning a specific source image for each media source
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3

Position your media within the physical wall to create a continuous wall display.

1: Media panel
2: Physical view
3: Input management tab
4: Position adjustments
5: Size adjustment

a

For each media source displayed in the Media panel, use your mouse to reposition it
in the physical view as needed. It may help to enable Snap from the Settings menu.

b

Instead of using your mouse, you can also go to the Input management tab to finetune the positioning and size adjustments.
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4.3 Adding devices
You must associate one or more devices to each media source.
1

From the Media panel, click on one of the available media sources.

1: Media panel
2: Device panel

2

From the Device panel, click the (+) button to add a new device to associate to your
media source.
A media source can have multiple devices associated to it when all devices have a
common source (e.g. a cloned source using a splitter device or with a multi-output
GPU).

3

Assign your devices.

1: Device data transfer tab
2: Assigned letter for each physical device
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4

a

Go to the Device data transfer tab.

b

Select a device from the list.

c

Upload your design to the selected devices.

Enable the Bezel adjustment grid.

1: Device management tab
2: Input source list
3: Apply button

a

For each device (click on a device in the Device panel), go to the Device
management tab.

b

From the Input source list, select Bezel adjustment grid.

c

Click Apply.

Your video wall monitors will now display the Bezel Adjustment Grid, with each monitor
showing an overlay ID (device letter and monitor number).

4.4 Adjusting the bezels
Bezel adjustment in Multi device mode is mostly the same as for Single device mode (see “Adjusting
grid wall bezels in Matrox PowerWall (single device mode)” on page 10) with the following additional
details and best practices:
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Start adjustment with the topmost-left monitor.



Adjust all monitors for one device before moving to the next device.



The same bezel adjustment grid will be shared across all devices so you can adjust the
bezels between them.



You can adjust the dimensions of
your physical wall at any time (via
the Input management tab or the
main PowerWall application
menu) to more closely fit the
monitors once they are aligned.

PowerWall menu

4.5 Validate your display wall
After you have adjusted the display wall, verify the following:


All horizontal and vertical lines are aligned across the gaps.



All diagonal lines are aligned across the gaps.



The vertical and horizontal line form square patterns (not rectangles) when the source
has a 1:1 pixel ratio.



On a large video wall, it is possible for the grid to become unaligned depending on the
viewing angle. Make your adjustments and verification from the same preferred viewing
position.

Once the validation process is complete, you can remove the Bezel Adjustment Grid.
1

Go to the Device management tab.

2

From the Input source list, select Video input, then click Apply.
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5 Adjusting artistic wall bezels in
Matrox PowerWall (Single device mode)
The following Artistic Wall setup will be used as an example in this section:

The input's source media is in UHD resolution, connected to one QuadHead2Go device with four
HD monitors (two 27” and two 39” generic models) in both landscape and portrait modes.
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5.1 Artistic wall creation and setup
This section describes the initial setup of your Single device design artistic wall in Matrox PowerWall.
1

Open Matrox PowerWall, click File > New design, select Single device design, then click
OK.

2

Give your media a name, select your source image, then click OK.
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3

Select your desired wall configuration, then click OK.

The Matrox PowerWall window opens to show the Physical display and the Source
display for the selected configuration. You can access all settings from the sliding panel
Menu.

1: Physical display
2: Source display
3: Sliding panel menu

This guide will focus on the physical view window. The Source view window is used for more complex
cases.
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5.2 Enabling the Bezel Adjustment Grid
For live bezel adjustment, the Matrox PowerWall design must be assigned to a physical device.
Uploading the design will send the current design information to the device. This step can be done
after each change in the design to see its impact, and must also be done prior to switching to Live
mode.
1

Assign the design to a device.

1: Device data transfer tab
2: List of physical devices
3: Upload button

a

Go to the Device data transfer tab.

b

Select a device from the list.

c

Upload your design to the selected devices.
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2

Enable the Bezel adjustment grid.

1: Device management tab
2: Input source list
3: Apply button

a

Go to the Device management tab.

b

From the Input source list, select Bezel adjustment grid.

c

Click Apply.

Your video wall monitors will now display the Bezel Adjustment Grid with each monitor
showing an overlay ID (monitor number):
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5.3 Adjusting the monitor source position
1

Specify the models for all monitors used for your artistic wall.

1: Output settings tab
2: Monitor management section
3: List of monitor manufacturers and models

a

Go to the Output settings tab.

b

From the Monitor management section, select the Manufacturer and Model for the
currently selected monitor.
If you can't find your monitor(s) listed, select the generic manufacturer option with
the model that matches the diagonal size of your actual monitor(s).

c

Repeat for each of your active monitors.

Some deformation can occur if the monitor model information is incorrect (e.g. when
using a generic manufacturer). Verify that all the monitors’ Bezel Adjustment Grid lines
have the same spacing. If they do not, you need to adjust the mismatched monitors.
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2

If needed, adjust mismatched monitors.

1: Output settings tab
2: Source adjustments section
3: Adjustment modes
4: Live mode
5: Monitor scaling

a

Go to the Output settings tab.

b

From the Source adjustments section, select Zoom.

c

Enable Live mode.

d

Adjust monitor scaling as needed until it has a similar grid spacing size as the other
monitors.
In Live mode, any adjustment of the source will automatically be applied, with the
new scaling showing immediately on the monitors.

e

When finished, disable Live mode.
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3

Set the initial position of the monitors of your artistic wall.

1: Output settings tab
2: Monitor output enable/disable
3: Monitor rotation

4: Physical view
5: Source position
6: Settings menu

a

Click the Output settings tab.

b

Disable the Output for each monitor you don’t need.

c

Correct the Rotation for each rotated monitor.

d

In the Physical view, use your mouse to reposition each monitor to its approximate
correct position.

e

(Optional) You can also set the monitor position in pixels from the Source position
section.

f

For a video wall with spacing between the monitors, you may want to disable the
snap feature in the Settings menu to make fine adjustments.
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4

Re-adjust and resize the media source.

1: Input management tab
2: Keep aspect ratio
3: Maximize button
4: Device data transfer

5

a

Go to the Input management tab.

b

Select Keep aspect ratio to prevent a distorted output.

c

Click Maximize to resize each monitor to the best fit of the source.

After changing the monitor model or media source size, you must reset the width and
height of each monitor.

1: Output settings tab
2: Source position section
3: Reset button
4: Device data transfer
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6

a

Go to the Output settings tab

b

From the Source position section, click Reset.

c

Repeat for each active monitor.

d

Go to the Device data transfer tab to upload the design changes to the device.

Enable Live mode.

1: Output settings tab
2: Source adjustments section
3: Mode list
4: Live mode enable/disable

a

Go to the Output settings tab

b

From the Source adjustments section, select Translate from the Mode list.

c

Enable Live mode to immediately apply the adjustment to the monitors.
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7

Adjust monitor positions in Live mode.

1: Live mode enable/disable
2: Translation adjustments

a

Make sure Live mode is enabled.

b

While looking at the physical display, make the needed Translation adjustments
using the Top, Bottom, Left, and Right positions per monitor.

c

Use the grid lines to help make the proper adjustments. At this point, you may see
black bars appearing on some monitor edges.

d

Adjustment should be done in the following sequence with the top-left monitor
acting as the initial reference point. Translate the other monitors one at a time using
the grid lines shared with the reference monitor. After the second monitor is
adjusted, it also becomes a reference for its shared edges with the other monitors.
Continue until you have successfully adjusted all four monitors.

e

Disable Live mode to see the change reflected in the Physical view.
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8

Resize the media source.
If the monitors’ positions are outside the source area (i.e. showing black bars on their
edges), or too far inside the source area, you can scale the source for a better fit.

1: Monitor outside source area
2: Input management
3: Keep aspect ratio
4: Maximize button

a

Go to the Input management tab.

b

Select Keep aspect ratio.

c

Click Maximize.

The media source will be stretched to cover every monitor’s active pixel
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9

Re-center the monitors in the source.
If needed, the monitors can be repositioned in the source (horizontally or vertically) to
be centered or better positioned over it.

1: Output settings tab
2: Source position
3: Horizontal and vertical offsets
4: Device data transfer tab

a

Go to the Output settings tab.

b

From the Source postion section, apply the same horizontal and vertical offset
values for all monitors.

c

Go to the Device data transfer tab to upload your design to the device.

You can also do this all in Live mode using Translation.

5.4 Validate your display wall
After you have adjusted the display wall, verify the following:


All horizontal and vertical lines are aligned across the gaps.



All diagonal lines are aligned across the gaps.



The vertical and horizontal line form square patterns (not rectangles) when the source
has a 1:1 pixel ratio

Once the validation process is complete, you can remove the Bezel Adjustment Grid and replace it
with your desired video input.
1

Go to the Device management tab.

2

From the Input source list, select Video input, then click Apply.
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6 Adjusting artistic wall bezels in
Matrox PowerWall (Multi-device mode)
The following Artistic Wall setup will be used as an example in this section

The inputs are cloned source media in UHD resolution, connected to two QuadHead2Go devices, for
a total of six monitors. One QuadHead2Go device is using all four of its outputs, three 27” generic
monitors and one 19” generic monitor. The other QuadHead2Go device is using two of its outputs,
both with 27” generic monitors.

6.1 Artistic wall creation and setup
This section describes the initial setup of your Multi device design artistic wall in Matrox PowerWall.
1

In Matrox PowerWall, click File > New
design > Multi device design.

2

Define the total size of your Physical wall
(you can change these dimensions later).

3

Click OK.
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The PowerWall window opens with your physical wall represented in light gray.

1: Media panel
2: Device panel
3: Physical view
4: Source view
5: Menu panel


You add and select a media source from the Media panel.



You add and select a device from the Device panel.



The light gray area represents the Physical view of your video wall.



Under the Physical view is the Source view section.



Access the PowerWall settings from the sliding Menu panel.

This guide will focus on the physical view window. The source view window is used for more complex
cases.

6.2 Add media sources
A media source represents a unique input source driving one or more devices.
1

From the Media panel, click the (+) button to add a new media source.
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The Add background media window opens.

2

Give your media a name, select your Source image, define the Aspect ratio and Size,
then click OK.

The physical size represents the dimension of the source applied on the physical video wall. The
source image is for use within the Matrox PowerWall application only. When you have multiple media
sources as part of a design, you can simplify the design process by assigning a specific source image
for each media source.
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6.3 Adding devices
You must associate one or more devices to each media source.
1

From the Media panel, click on one of the available media sources.

1: Media panel
2: Device panel

2

From the Device panel, click the (+) button to add a new device to associate to your
media source.

A media source can have multiple devices associated to it when all devices have a common source (e.g.
a cloned source using a splitter device or with a multi-output GPU).

6.4 Enabling the Bezel Adjustment Grid
For live bezel adjustment, the Matrox PowerWall design must be assigned to a physical device.
Uploading the design will send the current design information to the device. This step can be done
after each change in the design to see its impact, and must also be done prior to switching to Live
mode.

45

1

Assign the design to a device.

1: Device data transfer tab
2: List of physical devices with an assigned letter
3: Upload button

2

a

Go to the Device data transfer tab.

b

Select a device from the list.

c

Upload your design to the selected devices.

Enable the Bezel adjustment grid.

1: Device management tab
2: Input source list
3: Apply button
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a

For each device (click on a device in the Device panel), go to the Device
management tab.

b

From the Input source list, select Bezel adjustment grid.

c

Click Apply.

Your video wall monitors will now display the Bezel Adjustment Grid, with each monitor
showing an overlay ID (device letter and monitor number).

6.5 Adjusting the monitor source position
1

Specify the models for all monitors used for your artistic wall.

1: Output settings tab
2: Monitor management section
3: List of monitor manufacturers and models

a

For each device (click on a device in the Device panel), go to the Output settings tab.

b

From the Monitor management section, select the Manufacturer and Model for the
currently selected monitor.
If you can't find your monitor(s) listed, select the generic manufacturer option with
the model that matches the diagonal size of your actual monitor(s).

c

Repeat for each of your active monitors.
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Some deformation can occur if the monitor model information is incorrect (e.g. when
using a generic manufacturer). Verify that all the monitors’ Bezel Adjustment Grid lines
have the same spacing. If they do not, you need to adjust the mismatched monitors.
2

If needed, looking at the physical display, adjust mismatched monitors.

1: Output settings tab
2: Source adjustments section
3: Adjustment modes
4: Live mode
5: Monitor scaling

a

Go to the Output settings tab.

b

From the Source adjustments section, select Zoom.

c

Enable Live mode.

d

Adjust monitor scaling as needed until it has a similar grid spacing size as the other
monitors.
In Live mode, any adjustment of the source will automatically be applied, with the
new scaling showing immediately on the monitors.

e

When finished, disable Live mode.
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3

Set the initial position of the monitors of your artistic wall.

1: Device panel
2: Output settings tab
3: Monitor output enable/disable
4: Monitor rotation

5: Physical view
6: Source position
7: Physical view (drag to resize)

a

For each device (click on a device in the Device panel), go to the Output settings tab.

b

Disable the Output for each monitor you don’t need.

c

Correct the Rotation for each rotated monitor.

d

In the Physical view, use your mouse to reposition each monitor to its approximate
correct position.

e

(Optional) You can also set the monitor position in pixels from the Source position
section.

f

In the Physical view, use your mouse to resize the media source if needed.

g

Make sure each monitor is positioned over its associated media source.
For a video wall with spacing between the monitors, you may want to disable the
snap feature in the Settings menu to make fine adjustments.
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4

After changing the monitor model or media source size, you must reset the width and
height of each monitor.

1: Output settings tab
2: Source position
3: Reset button
4: Device data transfer

a

For each device (click on a device in the Device panel), go to the Output settings tab.

b

From the Source position section, click Reset.

c

Repeat for each of your active monitors.

d

Go to the Device data transfer tab to upload the design changes to the device.
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5

Enable Live mode.

1: Output settings tab
2: Source adjustments section
3: Mode list
4: Live mode enable/disable

6

a

For each device (click on a device in the Device panel), go to the Output settings tab.

b

From the Source adjustments section, select Translate from the Mode list.

c

Enable Live mode to immediately apply the adjustment to the monitors.

Adjust monitor positions in Live mode.

1: Live mode enable/disable
2: Translation adjustments
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a

Make sure Live mode is enabled.

b

Make the needed Translation adjustments using the Top, Bottom, Left, and Right
positions per monitor.

c

Use the grid lines to help make the proper adjustments. At this point, you may see
black bars appearing on some monitor edges.

d

Adjustment should be done in the following sequence with the top-left monitor
acting as the initial reference point. Translate the other monitors one at a time using
the grid lines shared with the reference monitor. After the second monitor is
adjusted, it also becomes a reference for its shared edges with the other monitors.
Continue until you have successfully adjusted all four monitors.

e

Disable Live mode to see the change reflected in the Physical view.

52

7

Resize the media source.
If the monitors’ positions are outside the source area (i.e. showing black bars on their
edges), or too far inside the source area, you can scale the source for a better fit.

1: Monitors outside source area
2: Input management tab
3: Keep aspect ratio
4: Resize with mouse
5: Edit menu

a

For each media source (click on a media source in the Media panel), go to the Input
management tab.

b

Select Keep aspect ratio.

c

Use your mouse to resize the media source as needed to get a correct fit.
The media source will be stretched to cover every monitor’s active pixel.

d

If needed, go to Edit > Resize physical wall to update the Physical wall’s dimensions
to match the new media source size.
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8

Re-center the monitors in the source.
If needed, the monitors can be repositioned in the source (horizontally or vertically) to
be centered or better positioned over it.

1: Output settings tab
2: Source position
3: Horizontal and vertical offsets
4: Device data transfer tab

a

Go to the Output settings tab.

b

From the Source postion section, apply the same horizontal and vertical offset
values for all monitors.

c

Go to the Device data transfer tab to upload your design to the device.

You can also do this all in Live mode using Translation.

6.6 Validate your display wall
After you have adjusted the display wall, verify the following:


All horizontal and vertical lines are aligned across the gaps.



All diagonal lines are aligned across the gaps.



The vertical and horizontal line form square patterns (not rectangles) when the source
has a 1:1 pixel ratio



On a large video wall, it is possible for the grid to become unaligned depending on the
viewing angle. Make your adjustments and verification from the same preferred viewing
position.
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Once the validation process is complete, you can remove the Bezel Adjustment Grid and replace it
with your desired video input.
1

Go to the Device management tab.

2

From the Input source list, select Video input, then click Apply.
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7 Disclaimer
Information in this document may contain technical inaccuracies or typographical errors.
Information may be changed or updated without notice. Matrox reserves the right to make
improvements and/or changes in the products, programs and/or specifications described in this
information at any time without notice. All trademarks and trade names, service marks and logos
referenced herein belong to their respective owners.
Copyright © 2021 Matrox Graphics Inc. All rights reserved. Matrox and Matrox product names are
registered trademarks and/or trademarks of Matrox Electronics Systems Ltd. and/or Matrox Graphics
Inc. in Canada and other countries. All other company and product names are registered trademarks
and/or trademarks of their respective owners.
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